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Currently recommended “stable” builds

• IBM internal:

– Latest client is 1351 (May 10th, 2019)

– Latest "stable" client is 1350 (April 26th, 2019)

• IBM external:

– Latest client is 1351 (May 10th, 2019)

– Latest "stable/announced" client is 1350 (April 26th, 2019)
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Feb 2019 (1345) – CSI – CS Objects – Create Collection times

4

• In CSI from the CS Objects folder the Create Collection option / window did not prefill the 

correct start and end times.
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Feb 2019 (1345) – CSI – Advanced CS Objects
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• In CSI, in the Advanced CS Objects folder renamed 2 columns as follows:

– Creation time -> Start time

– Change time -> End time

• Note #1:  These times are the accurate start and end times for the data inside of the 

*MGTCOL if using the Advanced CS Objects folder only. 

• Note #2:  The creation time and change time columns in the CS Objects folder by contrast 

refer to just the *MGTCOL object itself and not the data within it.
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April 2019 (1350) – CSI - Temporary storage calculation fix

6

• In CSI the calculation for the situation "Temp storage used is potentially too high and may 

disrupt SQL plan cache auto-sizing" was incorrect and has been fixed.

• This same miscalculation issue also effected the 1st 3 graphs in the CSI – temporary 

storage folder for the Y2-axis metrics.
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March 2019 (1346) – CSI – Job Summary analysis 

7

• Updates for the Job Summary analysis:

– At 7.3+ added support for new fields JBPGAI, JBPGDI, JBTMPPGAI, JBTMPPGDI

– Renamed JBPGA and JBPGD to be clear that these values are since the thread started.  

– Added new fields JBPGACOL , JBPGDCOL to include the delta pages allocated or deallocated 

during the summary period time.

– Several fields from file QAPMJOBOS where showing NULL values in some cases and have 

been changed to 0s.

– Analysis would fail if a time filtering was set.
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April 2019 (1350) – CSI – System graphs – Memory pool size updates
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• In CSI – System graphs, all graphs that show memory sizes have the following updates:

– Pool #3 is no longer using white as its color.

– All memory size fields were (slightly) incorrect. 

– Memory sizes are now in gigabytes. 
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Feb 2019 (1345) – CSI – System graphs removed
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• These graphs that show averages within a categorized bucket were deleted since they 

might be misleading:

– System graphs -> Interrupts -> Interrupts average time categorized totals

– System graphs -> TLBIEs -> TLBIE average time categorized totals

– System graphs -> TLBIEs -> TLBIE average time categorized totals per partition
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Feb 2019 (1344) – CSI – Collection properties – System tab
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• Updated the CSI – Collection Properties – System tab so that the partition memory value is 

retrieved correctly if the value is > 9.5 Terrabytes (TBs.) 

– Note:  These PTFs are required:

• 7.3 PTF SI64302

• 7.2 PTF SI64289



© 2018 IBM Corporation

™

April 2019 (1350) – CSI – Collection properties – Disk units tab updates
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• In CSI – Collection properties - Disk units tab, made the following updates:

– Disk capacity (in GB) was incorrectly reported previously and has been fixed.

– Changed the Reads per second (in KBs) as well as Writes per second (in KBs)  to show the 

value in megabytes instead to be consistent with the disk graphs

– Removed these columns:  TOTBLKRDS, TOTBLKWRTS, DSNBSY, DSSMPL

– Added these columns: DSMU, DSIP (multipath and initial path indicators)
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Feb 2019 (1345) – CSI/JW - Collection search report titles enhanced
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• When performing a collection search in CSI or Job Watcher, added extra details to the 

report title about which filtering options and preferences were used.
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March 2019 (1346) – CSI – Disk configuration – Raid type parity set 
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• Most disk configuration reports now include RAID type parity set.
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April 2019 (1350) – CSI – Disk configuration – Total usable GBs fixed 

14

• In CSI, in the disk configuration folder corrected the calculation for Total usable GBs 

(TOTALGBS)  for the Capacity (in GBs) by ASP reports.  

– It was in gibibytes previously and not gigabytes.
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April 2019 (1349) – CSI – Disk graphs – Color changes

15

• In CSI, made the color for the Average write response time (WRTAVGRSP) a bit lighter so 

it will show up better on some graphs.

• Also changed Average write size (AVGKBPERWRT) as a result as well.
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April 2019 (1350) – CSI - Disk graphs – Total drive capacity calculation 
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• In CSI, corrected accuracy problems with the DRIVECAP column (Total drive capacity) in 

the various disk graphs.  

– Note: This is the total drive capacity for the current bar.
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April 2019 (1350) – CSI – Disk graphs size calculation fixes 
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• In CSI, disk graphs fixed the following columns shown in the various graphs:

– AVGKBPERRD, AVGKBPERWRT,  (average I/O sizes)

– TOTREADMB, TOTWRTMB,  (total I/O size)

– DRIVECAP, (drive capacity)

– MBPERSEC, RMBPERSEC, WMBPERSEC,  (I/O size rates)

– Note: The values previously were in mebibytes or gibibytes and not megabytes or gigabytes.
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March 2019 (1346) – CSI – Disk graphs – Y2 axis changes
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• Most disk graphs on the Y2-axis now display the following:

– Average read response time

– Average read service time

– Average write response time

– Average write service time

• Note: Graphs that don't show response times will now all identify what's on the Y2-axis in 

the graph title.
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Feb 2019 (1345) – CSI - Disk graphs deleted

19

• These graphs that show averages within a categorized response time bucket were deleted 

since they might be misleading:

– Read/write categorized average response times for ASP <<DSASP>>

– Read/write categorized average service and wait times for ASP <<DSASP>>

– Categorized average response times for ASP <<DSASP>>

– Categorized average service and wait times for ASP <<DSASP>>

– Advanced -> Advanced average response time for ASP <<DSASP>>
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March 2019 (1346) – CSI – Disk graphs hidden 

20

• In CSI – disk graphs, the following graphs have been hidden:

– Device operations rate

– Read/write size and ethernet rates

– Read/write size and ethernet rates with total MB/sec

– Categorized rate with cache statistics

• Note:  If desired these can be reshown again later using the new "Show" button found in 

the Graph search pane.
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March 2019 (1346) – CSI – Disk graphs reordered (1/2) 

21

• In CSI at 7.1 and higher the new order for the disk graphs is:

– Read and write rates for ASP <<DSASP>>

– Read/write size averages for ASP <<DSASP>>

– Read/write size rates for ASP <<DSASP>>

– Read/write categorized total response times for ASP <<DSASP>>

– Read/write categorized total service times for ASP <<DSASP>>

– Read/write categorized totals for ASP <<DSASP>>

– Read/write categorized rates for ASP <<DSASP>>

– Read/write size totals for ASP <<DSASP>>

– Read/write totals for ASP <<DSASP>>

– Read/write rates with cache statistics for ASP <<DSASP>>

– Read/write rates with average sizes for ASP <<DSASP>>

– See next slide for the rest…



© 2018 IBM Corporation

™

March 2019 (1346) – CSI – Disk graphs reordered (2/2) 

22

• Continued from previous slide….

– Categorized totals for ASP <<DSASP>>

– Categorized rates for ASP <<DSASP>>

– Total queue elements with average length for ASP <<DSASP>>

– Log sense commands with average log sense response time for ASP <<DSASP>>

– Buffer overruns/underruns for ASP <<DSASP>>

– Device operations read/write rates for ASP <<DSASP>>

– Device operations read/write totals for ASP <<DSASP>>

– Disk percent full for ASP <<DSASP>>

– Disk percent busy for ASP <<DSASP>>

• Note: At 6.1 CSI, most disk graphs have been removed.
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March 2019 (1348) – CSI – Disk graphs  - Advanced reordered

23

• In CSI Disk graphs -> Advanced the folder now contains:

– Advanced read/write rates for ASP <<DSASP>>

– Advanced write rates for ASP <<DSASP>>

– Advanced read rates for ASP <<DSASP>>

– Advanced total response times for ASP <<DSASP>>

– Advanced write response times for ASP <<DSASP>>

– Advanced read response times for ASP <<DSASP>>

– Advanced total service times for ASP <<DSASP>>

– Advanced write service times for ASP <<DSASP>>

– Advanced read service times for ASP <<DSASP>>

– Advanced read/write totals for ASP <<DSASP>>

– Advanced write totals for ASP <<DSASP>>

– Advanced read totals for ASP <<DSASP>>
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April 2019 (1350) – CSI – External storage links and ranks updates (1/4)

24

• The I/O sizes shown in the CSI -> Hardware -> External storage links and ranks graphs for 

all types (SCSI, PRPC and Ranks) were being converted incorrectly from kilobytes to 

megabytes.
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April 2019 (1350) – CSI – External storage links and ranks updates (2/4)  
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• In CSI - Hardware - External storage links and ranks, the Ranks folder and all subfolders 

graph contents have been reorganized using similar conventions as the CSI - Disk graphs.  

• These graphs that combine reads+writes were deleted:

– Ranks rates

– Ranks size averages

– Ranks size rates

– Ranks size totals

– Ranks totals
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April 2019 (1349) – CSI – External storage links and ranks updates (3/4)  

26

• In CSI, changed the contents and order of several graphs under Hardware -> External 

storage links and ranks to match conventions made to the CSI - Disk graphs.  

• The folders changed are:

– Hardware -> External storage links and ranks

– Hardware -> External storage links and ranks -> SCSI Links (and all sub folders)

– Hardware -> External storage links and ranks -> PPRC Links (and all sub folders)
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April 2019 (1349) – CSI – External storage links and ranks updates (4/4)  
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• In CSI, the external storage links and ranks analysis has been updated to avoid showing 

very large negative numbers if the counters used by that analysis have wrapped.  

– Note: This previously could happen at any time if the 4 byte integer used for any metrics 

exceeded its maximum.
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April 2019 (1350) – CSI – JVM graphs updates

28

• In CSI in the JVM graphs folder the sizes listed were shown in mebibytes and not 

megabytes.

• Also the Total JVMs value was incorrect..  

• Also if selecting multiple JVMs from the JVM graphs -> JVM rankings graphs and drilling 

down the multiple JVM heap sizes were averaged together instead of summed and is now 

fixed.
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April 2019 (1350) – CSI – drill down crash 
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• Fixed a possible drill down crash in CSI if no selection was made when right-clicking 

outside of a bar (on white space.)
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Feb 2019 (1345) – CSI – Performance improvement   
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• In CSI made a performance improvement for the following graphs by removing a 

CHAR(HEX()) comparison when doing joins on the TDEs in the SQL statement:

– 1.  Wait graphs -> Dispatched CPU rankings

– 2.  Wait graphs -> Disk time rankings

– 3.  Wait graphs drill down -> <<OBJTYPE>> wait time signature for <<OBJDESC>>
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March 2019 (1346) – CSI - Launch WLE 

31

• In CSI, the launch workload estimator option from a collection does not work if C:\temp 

directory did not already exist on the PC.

• The function will now use iDoctor's temp directory which will properly create the directory 

and file.
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April 2019 (1350) – General – Add Connection port lookup mode 

32

• On IBM i connections from the Add/Edit Connection window added an option "Port lookup 

mode" with possible values of Default, Server, Local and Standard.  This will set the the

cwbCO_SetPortLookupMode API's setting for the ACS/CA connection.

• This gives you some control over the (server) ports used on the IBM i for the QZDASOINIT 

/ QZRCSRVS jobs used by iDoctor.  
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April 2019 (1350) – General – Can’t find local .mdb
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• If unable to connect to a local iDoctor DB (such as iDocCS.mdb) when starting up a 

component, the error message will now list the file location from the Windows registry's 

ODBC setting where iDoctor is looking.
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Feb 2019 (1344) – General - ODBC fix related to DB2 mirror on 7.4

34

• Fixed a possible infinite loop that would continually end and reconnect the QZDASOINIT 

session if an unexpected error occurred on an SQL statement during the fetch of data. 

• Reproducing this behavior also required skipping an initial signon via the IBM i connection 

view to the system and just immediately using the interfaces like WRKOBJ, WRKOBJLCK. 

• Also the error that occurred on the fetch will now be displayed to the user where previously 

this was not visible.
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March 2019 (1348) – General – GDI limit fix 
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• The options to increase/restore the windows GDI limit was broken on Windows 10 and is 

now fixed.  

– This is useful if you wish to open many graphs at once or need to build very large/complex 

graphs showing many points.

• Use the Edit -> Increase Windows GDI limit or Edit -> Restore Windows GDI limit menus 

from the Main Window.  

– Note:  Rebooting the PC as well as having admin level authority is required!

• Also in the iDoctor install directory you will find a new file SetGDILimitTo64K.reg which if 

executed will apply the required change to increase the limit to the maximum.



© 2018 IBM Corporation

™

March 2019 (1348) – General – Apply Keys fixes 

36

• In some situations the Apply Keys menu option from the IBM i Connections View did not 

work well and would prompt the user to signon too many times:

– The IBM i connections view now contains 2 additional columns after VRM:  Default user mode 

and User.

• This lets you see/control which user profile will be used to make the connection on each system before 

using the Apply Keys option.

– The menu option Set Default Signon now contains 2 sub menus options -> All Systems or -> 

Selected System(s.)

• If Set Default signon -> All Systems is selected, then all IBM i connections default user mode will be set 

to "set specific user ID" and user will be whatever value is typed in.

• If Set Default Signon -> Selected systems is selected, then the same thing would happen but only for 

the selected systems.
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March 2019 (1348) – General - Signon save password option

37

• Save password was not always working on the signon window.
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March 2019 (1346) – General – Pie label style 

38

• Changed the default setting for "Pie label style" (in graph definition -> General screen) to 

“Sutomatic".

• Also if the pie chart comes up and you don't like what you see for labels there are new 

options under the graph's right-click graph definition menu -> Set pie label style.

– Or enter the Graph definition -> General page you can modify this setting there to control what 

appears on the graph.
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March 2019 (1346) – General – Toolbars 

39

• We have disabled the ability to move toolbar and menus around in both the Main Window 

and Data Viewer.  The View -> Customize... option to customize the toolbars and menus 

has been removed as well.

• Note:  The one option that remains is you can still click the little arrow at the bottom right of 

the toolbar to remove any buttons you don't wish to see.
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March 2019 (1347) – General - Graph search updates (1/2) 

40

• On the graph search pane made these changes:

– Hidden ONLY checkbox: if checked the results will ONLY include the graphs or table reports 

that are hidden from view within iDoctor.  

– Hide button: will hide all selected graphs/reports that match the group IDs selected.  

• For example in CSI the Collection overview time signature graph has a group ID of 1 but exists in 

several different locations and for various OS VRMs.  Selecting 1 of these graphs in this interface and 

pressing the Hide button will hide them all.  

• Please note that some table reports do not have a group ID.  These are used in various interfaces 

within IDoctor and cannot be hidden.

– Show - This button will show any previously hidden reports shown in the graph search results.  

– Restore Defaults - This will restore the IBM shipped defaults for all components in terms of 

which graphs/reports are hidden and which are shown.   
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March 2019 (1347) – General - Graph search updates (2/2) 

41

• On the graph search pane added new columns to the search results as follows:

– Hide - An X value indicates if the graph or table is hidden from view within iDoctor.  Users can 

control which graphs or tables they want to see with this client build and higher.  These changes 

are stored in the windows registry.

– Group ID - The group ID column is a number that is used to identify the same graph or table but 

shown in different ways (such as overview, rankings, or selection over time.  This group ID value 

is used to be able to hide or show all graphs of a type selected in the interface more easily.
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Feb 2019 (1345) – General – SQL registers 

42

• When iDoctor runs SQL statements normally via the GUI all QZDASOINITs created will 

register the application name as IDOCTOR in the SQL special registers.

• Made an update so when running SQL statements in batch when kicking of any iDoctor 

analyses, the client application special SQL register will also be set now to IDOCTOR in 

the batch job QIDRJWSUM. (Note: this job name is used for all components).  This is also 

done if using the QIDRGUI/STRIDRSUM command.  

• This will cover 99% of the SQL statements ran by iDoctor, a few other places exist in 

commands that run, but those are not typically long running
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Feb 2019 (1345) – General – Toggle idle waits fix 

43

• In CSI or Job Watcher , the toggle idle waits toolbar button in the Data Viewer would show 

all wait buckets, but when toggled back the original graph did not return back to its original 

state.  It would always display all interesting wait buckets instead of what was originally 

shown for that graph (such as DB record locks time only, if viewing the DB record lock time 

signature).

• Also the button did not work for wait bucket counts graphs (it would switch it to show times 

instead) and has been fixed.
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Feb 2019 (1345) – General - Remote SQL statement status view updates

44

• Made the following fixes and updates in the Remote SQL Statement Status View:

– The Add SQL Statement window/option would allow a user to run an SQL statement without 

specifying a system name causing the window to become unusable.

– Running a SELECT statement would cause the window to become unusable after the 1st use 

and future executions of SQL statements would fail with Invalid cursor state.  The cursor is now 

cleaned up although no results can be shown currently by running SELECT or WITH statement 

in this interface.

– Added new menu options Rerun SQL Statements -> Same LPAR(s) and Rerun SQL Statements 

-> Other LPAR(s) to reexecute the desired SQL statements.

– Note:  See the update history for more details.
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Feb 2019 (1345) – General – iDoctor FTP GUI - Libraries folder

45

• The iDoctor FTP GUI Libraries folder will now show either all libraries on the system or only 

libraries matching the generic library name filter.  

– Note: This means it will no longer include libraries based on those matching the object filters 

defined in the object filtering window.
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Feb 2019 (1345) – General – iDoctor FTP GUI - Objects folder

46

• In the iDoctor FTP GUI, 2 new folders were added:

– Objects - contains all objects on the system that match the object filters, but faster and only 

contains 5 columns.

– Objects – Advanced – contains all objects on the system that match the object filters but slower 

and contains many more columns such as object size.  The columns shown and ordering can 

also be configured on this folder using the Select fields... menu option.
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Feb 2019 (1345) – General - Preferences – SQL 

47

• On the Preferences -> SQL tab added an option to specify the parallel processing degree 

parameter for the CHGQRYA command.  It includes the following options / values:

– Default = *SAME

– None = *NONE

– IO = *IO

– Optimize = *OPTIMIZE

– Max = *MAX

– System value = *SYSVAL
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Feb 2019 (1345) – General - IBM i connections options removed

48

• The following menu options found when right-clicking a connection in the IBM i

Connections View have been removed:

– 1) Load iDoctor Stored Procedures

– 2) Remove iDoctor Stored Procedures

– 3) Delete Obsolete Analysis Files
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Feb 2019 (1343) – JW – Collections folder added

49

• In JW added a Collections folder under the Job Watcher folder that is used to display all 

collections found on the system matching the library filter set. Note that this option can take 

a long time to run in some situations and should be used with caution. 

• This provides the following capabilities:

– Graphing multiple collections from multiple libraries at once.

– Searching collections from multiple libraries at once.

– Using the Report Generator option for collections in multiple libraries.
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March 2019 (1346) – JW – Temporary storage allocations 
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• In JW - temporary storage ->  Job temporary storage allocations graph, renamed the 

column description for SYAJOBTMPGB from "Temp storage allocations for active jobs 

(GBs)" to "Temp storage allocations (GBs)“ so that the total includes inactive jobs. 

• Note:  The collection summary analysis is now required to show this graph.
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Feb 2019 (1345) – JW – Call stack summary report added 
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• In Job Watcher added a new report in the Call stack summary folder:

– Programs calling reclaim APIs.
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March 2019 (1348) – JW – Call stack drilldown updates

52

• In Job Watcher - call stack window made these to the call stack (drill-down) reports:

– In the Total occurrences: by job report the total value was incorrect.

– In the Occurrences by interval: for this job/task the sorting will now be by interval instead of 

total.
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March 2019 (1346) – JW – Physical Disk I/Os updates

53

• In Job Watcher in the Physical disk I/Os folder, corrected calculations made in the following 

graphs:

– Pages allocated/deallocated (overlapping bars)

– Net pages allocated

• Note: Pages allocated/deallocated for 1st interval a job was detected in the collection 

would often be reported incorrectly (much too high.)  
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March 2019 (1346) – JW – Temporary storage  
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• In Job Watcher in the Temporary storage folder, corrected calculations made in the 

following graphs:

– Temporary storage pages allocated/deallocated (overlapping bars)

– Net temporary storage pages allocated

• Note: Temporary pages allocated/deallocated for 1st interval a job was detected in the 

collection would often be reported incorrectly (much too high.)  
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March 2019 (1346) – JW – Interval Summary interface (1/5)

55

• In Job Watcher in the interval summary interface updated the layout of tab names and 

content to more closely match what is found in the interval details interface for consistency:

– General section: added Temp storage job allocations (GBs)



© 2018 IBM Corporation

™

March 2019 (1346) – JW – Interval Summary interface (2/5)

56

• The Physical disk I/Os tab now contains the same columns (and layout) as in the Interval 

details - Physical disk I/Os tab.
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March 2019 (1346) – JW – Interval Summary interface (3/5)

57

• The logical DB tab now contains all 8 LDIO fields instead of just 3.
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March 2019 (1346) – JW – Interval Summary interface (4/5)
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• Added an SQL tab that contains 18 new SQL related metrics such as SQL statements 

executed and SQL-file full opens.  (at 7.2+)
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March 2019 (1346) – JW – Interval Summary interface (5/5)
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• Updated the Other statistics tab to contain the same fields as in the interval details 

interface.

– Note: Transaction tab removed and its metrics added here.
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March 2019 (1346) – JW – Interval Details updates (1/5)
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• In Job Watcher in the Interval Details interface made the following updates to improve 

consistency with the graph folders and having the same metrics available:

– The General section at the top of most tabs will now include Job CPU % and Temp storage (MB) 

(current and peak since the job started) for the current job in the interval.  

– Note:  Temp storage is is only available at 7.2 and higher.
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March 2019 (1346) – JW – Interval Details updates (2/5)

61

• In the Physical disk I/Os tab the Other I/Os section has been renamed to "Other metrics" 

and the list will now include:  

– Total pages allocated

– Total pages allocated since job start

– Temp pages allocated since job start

– Total pages deallocated

– Total pages deallocated since job start

– Temp pages deallocated since job start
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March 2019 (1346) – JW – Interval Details updates (3/5)
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• In the Logical DB tab renamed the metric "Logical others" to "Logical updates and 

deletes".  Also added these new fields:

– Logical force end of data

– Logical commits

– Logical rollbacks

– Logical index rebuilds

– Logical sorts
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March 2019 (1346) – JW – Interval Details updates (4/5)

63

Added a large number of SQL-related metrics to the SQL tab in the Other information section.
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March 2019 (1346) – JW – Interval Details updates (5/5)

64

• The Other statistics tab now contains these metrics in order to match the metrics found in 

the Other statistics folder.

– Displays I/O response transactions

– Displays I/O response transactions per second

– Average display transaction response time (milliseconds)

– Spool files created

– Jobs submitted
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Feb 2019 (1345) – JW – Reclaim resources situation 

65

• In Job Watcher added a new situation to check if the reclaim resources CPP was detected 

in any call stacks.
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Feb 2019 (1345) – JW – Wait graphs - Counts graphs

66

• Added a Wait graphs -> Counts folder and graphs similar to what is found in CSI whether 

the collection has been summarized or not.

• The new graphs are:

– Collection overview counts signature

– Seizes and locks counts signature

– Contention counts signature

– Disk counts signature

– Journaling counts signature

– Communications counts signature
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Feb 2019 (1345) – JW – Job Summary analysis – generic totals 

67

• In the Job Watcher job summary analysis the generic job totals file did not add up some 

metrics from file QAPYJWPRC correctly.  Fields like LDIO reads were inaccurately counted 

up.
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Feb 2019 (1345) – JW – CPU_SWITCH removed in most graphs

68

• Remove dispatched CPU counts (field CPU_SWITCH) from the secondary Y-axis where it 

appears on most graphs that show CPU utilization in CSI and Job Watcher.

• It still appears on the following graphs and will also appear in the table below all graphs 

that showed it previously:

– Wait graphs -> Virtual CPU Delays

– CPU graphs -> Dispatched CPU breakdown and CPUQ

– CPU graphs -> Dispatched CPU/CPUq usage by high/low priority with CPU utilization
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Feb 2019 (1345) – JW – Detail reports - Call stack summary flyover

69

• In JW, from the Detail reports -> 16, N or 50  level call stack summary reports, when 

placing your mouse over a program name in the call stack the IBM program descriptions 

will now be shown in the tooltip.  

– Note:  This is only for known IBM defined programs where a description is available..
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Feb 2019 (1345) – JW – Detail reports - N level call stack summary
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• In Job Watcher, from Detail reports added a new option "N level call stack summary" that 

will prompt the user for the desired number of max call levels and then build the report 

based on that number.  

– Note:  Keep in mind the bigger the number entered, the slower that this report will be!
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Feb 2019 (1345) – PEX – Physical disk I/Os graphs deleted
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• These graphs that show averages within a categorized response time bucket were deleted 

since they might be misleading:

– Read/write categorized average response times for <<OBJTYPE>> <<OBJDESC>>

– Read/write categorized average service and wait times for <<OBJTYPE>> <<OBJDESC>>

– Categorized average response times for <<OBJTYPE>> <<OBJDESC>>

– Categorized average service and wait times for <<OBJTYPE>> <<OBJDESC>>
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Feb 2019 (1345) – PEX – bucketized TPROF reports update
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• Added additional entries to the QIDRPA/COMPONENTS table used by the PEX 

"bucketized" tprof reports.  

– Note:  Latest server builds required.
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March 2019 (1346) – PEX TPROF 
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• In PEX TPROF under the cacheline drill down folder added a new report called "Object 

resolution and total hits for cache line <<CACHELINE>>"
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March 2019 (1346) – Disk Watcher 
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• In Disk Watcher made the following fixes:

• 1.  In the stats graphs the selected unit, selected path or selected pool drill down from the 

ranking graphs did not show up and are back now.

• 2.  The trace graphs folder would show up incorrectly if no QAPYDWTRC file existed if the 

user ran the Trace summary analysis.

• 3.  The trace graphs will now show time periods where no IOs occurred with gaps correctly 

now.
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Feb 2019 (1345) – Plan Cache Analyzer – plans graphs update
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• In the Plans graphs in Plan Cache Analyzer added the field QQTIM1 (Timestamp of last 

access plan rebuild) to the flyover.

– Note: The table below the graph now includes both QQSTIM and QQTIM1.


